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Adobe Illustrator | About this Guide

About
 ○ This guide was created by James Wamser, an Adobe Certified Instructor, to use as a reference while teaching.

 ○ Feel free to share your comments, errors or how you use it:

Community Help
 ○ Thanks to Steve Werner and Jim (ProDesignTools.com)

Illustration
 ○ Thanks to GlischkaStudios for the great Illustration.

New Features
 ○ Taken primarily from Adobe.com, Adobe New Features documents and Adobe Press Releases.  
https://www.adobe.com/products/Illustrator/features.html

Brief History
 ○ Adobe Illustrator was first developed for the Apple Macintosh as a commercialization of Adobe’s in-house font 
development software and PostScript file format.  

 ○ In January 1987, Adobe Illustrator 1.0 was launched (Mac only).

 ○ In January 1989, Adobe Illustrator 2.0 for Microsoft Windows personal computers was released.

 ○ May 6, 2013–Creative Cloud was announced at Adobe MAX in LA and dropped on June 17, 2013.

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
mailto:jameswamser%40mac.com?subject=Illustrator%20New%20Features%20Guide
https://www.glitschkastudios.com
https://www.linkedin.com/in/jameswamser/
mailto:jameswamser%40mac.com?subject=


Contents Index Favorites Info OnlineFeedback

Adobe Illustrator CS6 16 April 23, 2012

6 iA-Z

Adobe Illustrator CS6 | April 23, 2012

Adobe Mercury Performance System
 ○ The Adobe Mercury Performance system is a combination of solutions that makes Illustrator faster, more responsive, and 
able to handle larger files.

 ○ 64-bit native support of RAM beyond 3 GB.

 ○ Handle larger files: Concurrent handling of large files is less likely to cause errors, like out-of-memory exceptions. Complex 
tasks, such as creating package designs, large-format graphics, or cartography, are better handled.

 ○ Improved memory handling simultaneously: Reduces out-of-memory errors for operations such as rasterization, export, 
and working on several large files simultaneously

Improved user interface
 ○ The user interface is more efficient, streamlined, and more configurable, to make working in Illustrator a more pleasing 
experience. For more information on the aspects of the user interface that have been improved, see Improved user 
interface.

Patterns
 ○ Pattern creation and editing tasks have been simplified, so you can save hours of repetitive and tedious work.

Gradient on a stroke
 ○ The gradient on a stroke feature provides you with three types of gradients to apply to a stroke. You no longer have to 
expand a stroke to fill it, and then apply a gradient to it. Apply a gradient to a stroke using the Gradient panel  
(Window > Gradient)

Version 16

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CS6 | April 23, 2012

Image Trace
 ○ The workflow to vectorize a raster image now produces much cleaner tracings. The output has fewer paths and anchor 
points, and better color recognition than the Live Trace feature in previous versions. 

Gaussian Blur
 ○ The new Gaussian Blur effect (Effect > Blur > Gaussian Blur) is speedy and efficient. Select the Preview checkbox to view the 
Gaussian Blur applied to your artwork, in real time.

New or improved profiles and components
 ○ Use the improved profiles and additional component libraries to get a quick start on your art projects:

 ○ A new profile named Devices has been introduced in the New Document dialog box (File > New).  
The new profile contains presets for the iPad, iPhone, Xoom, Fire, Nook, and Galaxy devices.

 ○ The Web profile has a new default size (960px x 560px).

 ○ New Pattern and new Pantone Plus™ color libraries have been added.

Efficient and flexible interface 
 ○ The newer usability enhancements enable you to use fewer clicks and fewer steps to achieve routine or frequent actions. 
For example, in the Character panel (Ctrl+T), the font list displays names in the font style itself. You can quickly pick the font 
of your choice from the list.

Inline editing
 ○ Easily work with Layers, Actions, Swatches, Symbols, and other panels, with the ability to edit object names directly in the 
panel. You no longer need an additional modal dialog for such routine actions. For example, double-click the name of a 
layer in the Layers panel to switch to inline editing mode. Type the new name and press Enter.

Version 16

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
mailto:jameswamser%40mac.com?subject=Illustrator%20New%20Features%20Guide


Contents Index Favorites Info OnlineFeedback

8 iA-Z

Adobe Illustrator CS6 | April 23, 2012

Quick-edit object attributes
 ○ In the user interface, values of object attributes are set through drop-down lists or text fields. You can now quickly edit 
these fields by hovering your mouse pointer over a control, and scrolling the mouse wheel. For example, to increase or 
decrease the weight of a stroke, hover the mouse pointer over the stroke weight control, and scroll.

Dialog boxes 
 ○ Buttons to commit an action or event are placed uniformly at the lower-right corner. Dialog boxes also have full keyboard 
access.

Workspaces 
 ○ New workspaces are task-based. A workspace can now 'remember' the state it was last left in, and then be reset to default 
settings when necessary.

 ○ New icons. Updated to enhance usability, newer icons contribute to a better, more intuitive interface.

 ○ Cursors. Modifications have been done to make cursors larger and more precise.

User interface color and brightness
 ○ Illustrator, by default, is now available with a dark theme, which is in line with recent changes in other products like Adobe 
Photoshop. This theme enables a more pleasant visual experience, especially while working with rich colors and designs.

Control panel 
 ○ Object controls that are used frequently are grouped and displayed together in the Control panel. Grouping controls in this 
manner helps you work with objects faster and more systematically.

Version 16

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CS6 | April 23, 2012

Transform panel
 ○ The Scale Strokes & Effects option has been included in the Transform panel and the Transform Effect dialog.

Transparency panel 
 ○ Masking features are now available in the Transparency panel. Use the Make Mask / Release toggle switch to create opacity 
masks and work with them more easily.

Version 16

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 17, 2013

Touch Type tool
 ○ Design with type by manipulating characters like individual objects. Move, scale, and rotate text, and still change the font or 
edit at any time. You can use multitouch devices as well as a mouse or stylus.

Images in brushes
 ○ Paint with a brush made from a photo. Art, Pattern, and Scatter brushes can contain raster images, so you can create 
complex organic designs quickly — with simple brushstrokes. As with all Illustrator brushes, your strokes can be reshaped 
and modified at will.

Font search
 ○ Quickly find the perfect font, fast. In the Character panel, type a style such as “bold” or “italic,” a font family, or any other part 
of a font name. You’ll get a filtered view that lets you see just the fonts that match your criteria.

Multiple file place
 ○ Import multiple files into your Illustrator layout at the same time and with control. Use thumbnail views to define the 
location and size of your files, which can be images, graphics, or text.

CSS extraction
 ○ Take visual designs to the web faster by letting Illustrator generate CSS code for you. Copy/paste or export code for text, 
objects, even entire layouts with images, directly into your HTML editor or for handoff to a web developer.

Color syncing
 ○ Capture color themes out in the world with the Adobe Kuler iPhone app. Share your themes and explore thousands of 
others available on the Kuler website. Sync your favorite themes, and they’ll be accessible immediately in Illustrator.

Version 17

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 17, 2013

Sync Settings
 ○ Synchronize your settings, including preferences, presets, libraries, and workspaces, to Creative Cloud and have the same 
working settings and environment on multiple computers, Mac or PC.

Auto corners for pattern brushes
 ○ Create pattern brushes quickly with a choice of auto-generated corners that perfectly match the rest of the pattern.

On-art Free Transform tool
 ○ Move, scale, and rotate objects directly using a touchscreen device. Or use a mouse or other pointer right on the artboard 
to transform objects in a more immediate and intuitive way.

Exchange panel
 ○ Discover plug-ins, extensions, templates, and other content that you can purchase or download for free from the new 
Adobe Exchange panel in Illustrator.

File packaging
 ○ With a single command, you can gather all your files, including linked graphics and fonts, into a single folder for 
organization or to hand off.

Unembedded images
 ○ Replace embedded images with links to their extracted PSD or TIFF files by selecting the image and choosing Unembed 
from the Links panel menu or clicking Unembed in the Control panel.

Version 17
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Adobe Illustrator CC | June 17, 2013

Expanded Links panel option
 ○ View and track additional information about placed artwork directly in the Links panel.

 ○ This update offers many other enhancements, including the ability to export unused SVG graphic styles, an option to avoid 
white overprint, support for Indic languages, and more.

Version 17
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Adobe Illustrator CC | January 16, 2014

Live Corners
 ○ Edit and re-edit the corners of shapes and paths with on-art controls or by entering values in the Control panel or new 
Corners dialog box. You can round, invert, or chamfer one or multiple corners at the same time.

Rebuilt Pencil tool
 ○ Draw curves more accurately with options to extend and close paths and draw straight lines. Use presets to create smooth 
paths with fewer points or more precise renditions of actual strokes. This new technology extends to the Brush, Blob Brush, 
and Smooth tools.

Path segment reshaping
 ○ Drag path segments into the shape you desire. New path reshaping technology, available in the Anchor Point and Direct 
Selection tools and accessible from the Pen tool, provides a more direct and intuitive way to edit path segments.

Adobe Typekit integration
 ○ Browse fonts from Typekit in the Type or Font Family menus, whether filtering directly in-menu or launching the Typekit 
website. Select from a growing library of desktop fonts from Typekit, sync them to your computer, and then use them right 
away in your projects.

Version 17.1

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | January 16, 2014

Windows 8 support for touch and pen pressure
 ○ Work with a pressure-sensitive pen on the latest Windows 8 tablet computers, along with enhanced direct touch support. 
Enjoy HiDPI display support for computers running Windows 7 and 8.

Custom Tools panels
 ○ Create specialized toolsets by dragging and dropping just the tools you need — like drawing, editing, or selection tools — 
into a custom panel. The full Tools panel can then be hidden, allowing for a clean, efficient workspace.

Settings import and export
 ○ Share your Illustrator settings across multiple computers. Simply export them to a folder where they can then be imported 
by other users. While Sync Settings lets you standardize settings on your own computers, now you can also share them 
across your organization.

Perspective drawing enhancements
 ○ Modify perspective grid attributes, such as vanishing points and the horizon line, and your artwork dynamically updates to 
match the new perspective. 

Responsive SVG export
 ○ Export scalable, responsive SVG files that can adapt to different screen sizes and resolutions, and roundtrip-edit SVG files 
that maintain precise pixel alignment.

 ○ This update also offers many other improvements, including the ability to resize artboards from the center, Fill/Stroke 
controls in the Swatches panel, sliders that control opacity, layers that remember open/closed state, and quick-canceling 
drag operations.

Version 17.1
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Adobe Illustrator CC | January 16, 2014

Responsive SVG export
 ○ Export scalable, responsive SVG files that can adapt to different screen sizes and resolutions, and roundtrip-edit SVG files 
that maintain precise pixel alignment.

And so much more
 ○ This update also offers many other improvements, including the ability to resize artboards from the center, Fill/Stroke 
controls in the Swatches panel, sliders that control opacity, layers that remember open/closed state, and quick-canceling 
drag operations.

Version 17.1

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 18, 2014

Live Shapes: Rectangles and Rounded Rectangles
 ○ Rectangles now have quickly modifiable corners, including independent radius control. Corner attributes are retained if you 
scale and rotate your rectangle. Now Illustrator remembers your work — width, height, rotation, corner treatment — so 
you can return to your original shape.

Pen tool preview
 ○ See the path you’re drawing before you drop your next point. A rubberband-like line from your last anchor point to the tip 
of the pen appears as you draw. Visualize where the next curve will go as you plot your next point — and spend less time 
cleaning up paths.

Anchor point enhancements
 ○ Fine adjustment of curves is now easier. New anchor point controls allow unequal or different-direction handles to be 
dragged as you draw to control the smoothness of each segment. You can even change a corner point to smooth without 
ruining your shape.

Snap to pixel, point, and grid updates
 ○ When snapping is turned on, your anchor points align perfectly to your choice of pixel, grid, or point. But your anchor 
handles should not. They’re now disengaged from snapping so you can preserve the precision of your curves and achieve 
fine control while editing.

2014 Release (version 18.0)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 18, 2014

Better path control
 ○ Close your paths with precision and predictability. As you complete a drawing, you now have more control connecting the 
end and start points. Reposition your closing point or choose to break the direction lines to adjust the closing curve exactly 
as you wish.

Windows GPU acceleration
 ○ New GPU acceleration for Windows lets you work faster on Windows 7 or 8 computers. This feature requires an Adobe-
certified NVIDIA graphics card with at least 1GB of VRAM.

2014 Release (version 18.0)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | October 16, 2014

Creative Cloud Libraries
 ○ Browse and access your favorite creative assets — colors, type styles, graphics, brushes, and more — in new libraries that 
are available in Illustrator, Photoshop, and mobile apps like Sketch and Draw. Libraries sync to Creative Cloud so you always 
have the files you need, right when you need them.

Touch workspace
 ○ Access the full power of Illustrator on the go using a new workspace optimized for your Microsoft Surface Pro 3 or any 
Windows 8 tablet. Get essential tools for drawing and editing with a pen and your finger in a touch environment, including 
French curves that you can scale, move, and trace.

Curvature tool
 ○ Draw refined curves and straight lines quickly and visually. Click once with the Curvature tool to place points and see the 
curve flex around them dynamically, or double-click to create corner points for straight lines. Edit using the same tool — no 
need to hassle with anchor points and handles.

Join tool
 ○ Easily join paths that cross, overlap, or have open ends — and simultaneously trim unwanted segments — without 
affecting the original path trajectories.

2014.1 Release (version 18.1)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 18, 2014

Area-type auto-sizing
 ○ Say goodbye to overset text boxes. Now, area type frames resize automatically as you add, delete, or edit text.

Integration with the Illustrator family of mobile apps
 ○ Seamlessly bring in artwork from Sketch, Line, and Draw, and enhance it using the full range of Illustrator tools for a 
complete mobile-to-desktop design workflow.

Color and shape inspiration anywhere
 ○ Create custom brushes, graphics, and colors using the Brush CC, Shape CC, and Color CC mobile apps, and then easily bring 
them into Illustrator via Creative Cloud Libraries to incorporate them into your designs.

2014.1 Release (version 18.0)
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Adobe Illustrator CC | June 15, 2015

Linked assets for universal updates
 ○ Assets in Creative Cloud Libraries can now be linked so that when a change is made to an asset, you and your team 
members have the option of updating it across any Illustrator, Photoshop, or InDesign projects where it’s used.

Adobe Stock to find the perfect image
 ○ The new Adobe Stock marketplace lets you find, license, and manage royalty-free images and vectors from within Illustrator 
CC. Select from 40 million assets, save your selection to your Creative Cloud Libraries, and then drag it into your project to 
use.

10x faster zoom, pan, and scroll
 ○ Thanks to an Adobe Mercury Performance System boost, you can pan, zoom, and scroll more than 10 times faster and more 
smoothly without slow, stepped changes.

 ○ 10x greater zoom magnification

 ○ Zoom into your artwork up to 64000% (up from 6400%) so you can create and edit with greater precision.

2015 Release (version 19.0)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | June 15, 2015

Auto-recovery of files
 ○ Never lose your work if Illustrator crashes and you’ve forgotten to save. Just relaunch and your file will be restored. Illustrator 
gives you the option of quickly diagnosing what caused the crash, such as a corrupt font, out-of-date driver, or missing 
plug-in.

Integration with new Adobe Comp CC
 ○ Create layouts for print, web, or mobile on your iPad. Pull creative assets into Comp from your or your team’s shared Creative 
Cloud Libraries, and then instantly send your layouts to Illustrator. All your text, images, and graphics are live and fully 
editable.

Use of Photoshop Sketch art in large-format designs
 ○ Scale Photoshop Sketch drawings up to four times their original size with no loss in quality.

And so much more
 ○ Also includes: New free-form merge/subtract mode for the Shapebuilder tool; Curvature tool updates for more flexible 
drawing; multiple enhancements to the Touch workspace; and much more.

2015 Release (version 19.0)
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Adobe Illustrator CC | November 30, 2015

New Creative Cloud Libraries capabilities
 ○ Find content faster by searching across your libraries and across Adobe Stock. Import color swatches and color groups, save 
color themes from libraries to swatches, and get support for paragraph styles, as well as deeper support for character styles.

Shaper tool
 ○ Draw shapes with loose, natural gestures that transform into perfect geometric shapes. Then combine, delete, fill, and 
transform these shapes to create beautiful, complex designs that stay fully editable. The Shaper tool works with the 
traditional Illustrator workspaces as well as the Touch workspace.

New Live Shapes: Ellipses, Polygons, and Lines
 ○ More of the Illustrator Shape tools are now fully live, interactive, and dynamically adjustable, so you can quickly craft vector 
shapes without having to apply effects or use other tools.

Dynamic Symbols
 ○ Symbols can now share a master shape but be modified to have different appearances such as stroke, fill, and opacity. 
Scale, rotate, mirror, and skew them without having to break the link to the parent symbol.

2015.2 Release (version 19.2)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | November 30, 2015

Enhanced Smart Guides
 ○ Smart Guides now let you perfectly align and space objects as you draw and move them, and new hinting helps you draw 
perfect shapes like squares and circles without using control keys.

New SVG export option
 ○ Easily export modern SVG — ideal for web and screen design workflows. You can choose to export individual objects 
versus the entire artboard.

Touch workspace updates
 ○ The Touch workspace for Windows tablets adds the Shaper tool, new Live shapes, enhanced Smart Guides, an option to 
easily zoom when using a mouse, and support for HP Sprout.

Adobe Capture CC integration
 ○ Use an iPad, iPhone, or Android phone to turn any image into a production-ready asset. Extract a color theme or create a 
brush, shape, or vector graphic, and then save the asset to your Creative Cloud Libraries to use in Illustrator.

Illustrator Draw for Android
 ○ Create free-form vector designs on your Android phone with the Adobe Illustrator Draw app, and then send your work to 
Illustrator on your desktop to refine it further.

2015.2 Release (version 19.2)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
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Adobe Illustrator CC | November 30, 2015

Enhanced Adobe Comp CC integration, plus iPhone support
 ○ Now you can use Comp CC to explore layout possibilities on your iPhone as well as your iPad. Assets in Comp can be linked 
so that when you edit them in Illustrator or another Creative Cloud desktop app, they’ll instantly update in Comp.

And so much more
 ○ Also includes: Better GPU performance thanks to enhanced anti-aliasing and crisper thin strokes; improved data recovery; 
and much more. 

2015.2 Release (version 19.2)
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Adobe Illustrator CC | June 20, 2016

Live Shapes and Transform panel updates
 ○ A consistent visual experience makes it easier to work with Live Shapes. Controls automatically hide as shapes are scaled to 
small sizes, and polygons maintain live characteristics after non-uniform scaling. Plus, shapes and paths can be reset to their 
original rotation in the Transform panel.

Adobe Portfolio to showcase work
 ○ Now when you use Portfolio to show off your Illustrator designs and artwork, you can create custom landing and contact 
pages to better connect with viewers.

Adobe XD integration
 ○ Copy and paste your Illustrator CC artwork directly into Adobe Experience Design CC (Preview), the new all-in-one tool for 
designing and prototyping user experiences for websites and mobile apps.

And so much more
 ○ Also includes: The ability to scroll through stroke width and text sizes in proper increments; guides that stay unlocked when 
hidden; the ability to turn the Pen tool into the Direct Selection tool by pressing Cmd/Ctrl when drawing; and more.

2015.3 Release (version 20.0)
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Adobe Illustrator CC 20.1 August 10, 2016

26 iA-Z

Adobe Illustrator CC | August 10, 2016

Adobe Stock search inside Illustrator
 ○ Access millions of high-quality Adobe Stock illustrations, vectors, and photos to use in your designs right from the search 
field in Illustrator. Your results will appear instantly on the Adobe Stock website.

Better collaboration with libraries
 ○ Control assets in read-only Creative Cloud Libraries so they can be used by team members, but not changed or deleted.

Updated Libraries panel
 ○ Find the assets you need faster with a larger Libraries panel, new filtered search of Adobe Stock, and icons that make it easy 
to identify licensed Adobe Stock assets.

Improved Adobe Stock integration
 ○ License Adobe Stock assets directly in Illustrator via the Libraries and Links panels. And when browsing assets on the Adobe 
Stock website, open assets directly in Illustrator.

Fast export of assets and artboards
 ○ Select individual assets from one or more artboards, or choose entire artboards, and click once to export them to multiple 
sizes, resolutions, and formats perfect for screen, web, and icon workflows.

2015.3.1 Release (version 20.1)
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27 iA-Z

Adobe Illustrator CC | November 2, 2016

Pixel-perfect artwork creation
 ○ Draw paths and shapes that seamlessly align to the pixel grid. Align existing artwork with a single click or by using simple 
transformations. Preserve Live Shapes and rounded corners, maintain alignment when scaling and rotating objects, and 
manually nudge segments and end points into perfect alignment.›

Faster font finding
 ○ Mark individual fonts as favorites to quickly find the one you need. Filter your list to see fonts you’ve recently used, find 
other fonts that are similar to one you like, or find fonts based on classifications like serif or handwritten.

Easier use of glyphs
 ○ Use alternate glyphs for any character by simply selecting the character and choosing from an in-context menu. View and 
insert your most recently used glyphs, and sort glyphs for faster browsing.

Quicker start to your designs
 ○ Jump-start design projects with easy access to presets as well as free Adobe Stock templates that you can access right from 
the File > New menu.

2017 Release (version 21.0)
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Adobe Illustrator CC | November 2, 2016

Adobe Stock templates and search
 ○ Adobe Stock includes new design templates, and now you can drag and drop Adobe Stock search results from your 
Libraries panel right into your canvas to start using right away. Plus, you can right-click on a stock image to do a visual 
search for similar images. 

New Creative Cloud Libraries capabilities
 ○ Libraries in Illustrator now support Adobe Stock templates. Plus, Send Link has been updated so you can now share read-
only access to a public library. When you follow a library, it appears in your Libraries panel and updates automatically.

Creative Cloud Assets improvements
 ○ Archive and restore all your assets stored in Creative Cloud, including the ones in your Creative Cloud Libraries, assets 
created with your desktop products, and mobile projects.

Introducing Typekit Marketplace
 ○ Now you can buy fonts from some of the industry’s biggest names and use them in your Illustrator projects. Adobe Typekit 
uses its font sync and web technologies to deliver your Marketplace fonts anywhere you need them.

Font and text enhancements
 ○ See a live preview by hovering over the font list with selected text, place loaded text inside a container, or fill a container 
with placeholder text to better visualize your designs. Easily work with type objects that have a common font family but 
different styles, and vice-versa.

2017 Release (version 21.0)
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Adobe Illustrator CC | November 2, 2016

Zoom to selection
 ○ View and edit faster now that you can zoom into anything you’ve selected — an active point, a segment, a path, or an 
object.

Modern user experience
 ○ A flat UI and new icons for tools and panels offer a cleaner look and help you focus on your artwork.

And so much more
 ○ Also includes: New keyboard shortcuts, stability improvements, and more. 

2017 Release (version 21.0)
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30 iA-Z

Adobe Illustrator CC | April 5, 2017

Crop images more easily
 ○ Crop bitmap images directly within Illustrator to discard excess parts, reduce file size, and improve performance. That 
means no need to use clipping masks or edit the image in Photoshop.

Create new documents faster
 ○ To improve speed and performance, the start screen for creating new documents now loads even faster than before. 

Redesigned Color Theme panel
 ○ Create, explore, save, and retrieve color themes across applications with the new Color Theme panel. Now you can explore 
popular themes and get help perfecting color choices.

Stability enhancements
 ○ You asked, we listened. We’ve fixed top Illustrator issues and improved stability.

2017.1 Release (version 21.1)
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31 iA-Z

Adobe Illustrator CC | October 18, 2017

Properties panel
 ○ Work faster with access to all your controls in one place. The new and intelligent Properties panel shows you only the 
controls you need, when you need them.

Easier artboard organization
 ○ Select multiple artboards at one time, and align and organize them automatically on your canvas in just a click. Objects 
locked to an artboard now move with it.

Text management in Creative Cloud Libraries
 ○ Libraries in Illustrator now support text, so you can store and access the passages you use most — like taglines, brand 
marketing descriptions, and other placeholder copy. Plus, share text between Illustrator and Adobe InDesign CC libraries.

Puppet Warp
 ○ Transform your vector graphics while maintaining a natural look. Puppet Warp lets you quickly create or modify a graphic 
without having to adjust individual paths or anchor points.

SVG color fonts
 ○ Design with fonts that include multiple colors, gradients, and transparencies thanks to support for SVG OpenType fonts.

More artboards
 ○ Now Illustrator lets you create up to 1,000 artboards on a single canvas so you can work with more content in each 
document.

CC 2018 (version 22.0)
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Adobe Illustrator CC | October 18, 2017

Variable fonts
 ○ Illustrator supports OpenType variable fonts, so you can modify a font’s weight, width, and other attributes to create your 
own style — while still maintaining fidelity to the original design.

Stylistic sets
 ○ Apply predefined glyph alternates to an entire block of text without having to individually select and change each glyph.

MacBook Pro Touch Bar support
 ○ Get instant access to core tools right when you need them on the contextual MacBook Pro Touch Bar.

CC 2018 (version 22.0)
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33 iA-Z

Adobe Illustrator CC | March 12, 2018

See on-screen controls clearly
 ○ You can now increase the size of anchor points, handles, and bounding boxes making them even easier to work with.

Merge data using CSV files
 ○ It’s easier than ever to merge data in the Variables Panel now that you can use CSV or XML files.

Import multiple page PDFs
 ○ Save time when you import all the pages of a PDF all at once. You can choose a page range or select individual pages.

Dropbox Smart Sync improvements
 ○ Now you can browse your Dropbox files without inadvertently downloading them.

CC 2018 (version 22.1)
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34 iA-Z

Adobe Illustrator CC | October 15, 2018

Freeform Gradients
 ○ New color blending capabilities let you create richer, photorealistic gradients that look more natural.

More accessible Adobe Fonts
 ○ Easily see and activate thousands of fonts within the app. Preview the selected font in your project, even if it’s not activated.

Faster zoom
 ○ We’ve improved zoom in outline mode so you can watch as your canvas shrinks and grows incrementally.

Global editing
 ○ Save time when you modify similar objects across multiple artboards — all at once.

Presentation mode
 ○ Each artboard becomes a slide you can preview, browse, and project in presentation mode.

Content-Aware Crop
 ○ This new feature, powered by Adobe Sensei, uses machine learning to provide suggested crops.

Visual font browsing
 ○ We’ve made it easier to browse different font classes to find the right font faster. And you can now choose from different 
sample text options, too.

Trim view
 ○ See exactly how your designs look without guides, grids, or elements extending beyond the edge of the artboard.

CC 2019 (version 23.0)
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Adobe Illustrator CC | October 15, 2018

Actual size preview
 ○ Preview your designs at their actual dimensions when you set the view to 100%.

Customizable toolbar
 ○ Add, remove, or group tools in your toolbar the way it works best for you.

Scaling to fit your monitor
 ○ Now you can customize the size of your tools, icons, menus, panels, and controls so they look just right.

Puppet Warp enhancement
 ○ Thanks to Adobe Sensei, pins are now automatically suggested so there’s no need to manually plot them.

CC 2019 (version 23.0)
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Adobe Illustrator | November 4, 2019

Path Simplification
 ○ Easy and quick editing of complex paths by reducing the number of anchor points.

Auto Spell-Check
 ○ All spelling errors highlighted right in the document as soon as you type the text.

Background save and export
 ○ Quick save and export of files. Now, you don’t need to wait to resume work on other tasks.

November 2019 release (version 24.0)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
mailto:jameswamser%40mac.com?subject=Illustrator%20New%20Features%20Guide


Contents Index Favorites Info OnlineFeedback

Adobe Illustrator 24.1 March 6, 2020

37 iA-Z

March 2020 release (version 24.1 (macOS) and version 24.1.1 (Windows))

Adobe Illustrator | March 6, 2020

Real-time drawing
 ○ Now, scaling of objects and application of effects on objects are not displayed as outlines, instead these tasks will fully 
render as you work.

Cut and copy artboards
 ○ Use Cut, Copy, and Paste options to create multiple copies of artboards across different documents.

Enhance free distort
 ○ Free Distort now lets you modify shapes freely through a bounding box, without any resetting.

Reduced document corruption issues
 ○ Illustrator will now automatically repair and recover the damaged documents, when possible.

Improved toolbar
 ○ Dragging and dropping of tools between the toolbar and the drawer is now easy.

Stability and performance
 ○ Better stability performance, and smoother workflows.
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38 iA-Z

Adobe Illustrator | June 16, 2020

Cloud documents
 ○ Save your work as cloud documents and access from anywhere Illustrator is installed. Track your version history and revert 
as needed. 

100x canvas
 ○ Create your large-format artwork like billboards, bus wraps, signage boards and more on a 100x large canvas area, which 
provides more design space and ability to scale.

Start and finish faster
 ○ Document create and save workflows are now quick with the fast loading of New document window and the fast saving of 
Illustrator cloud documents.

Adobe Illustrator Logo
 ○ Adobe has changed the color and design of the logo over the years. This release has a new logo.

June 2020 release (version 24.2)
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39 iA-Z

Adobe Illustrator | August 20, 2020

Snap to glyph
 ○ Achieve quick and precise alignment around the boundary of live text, without the need of creating outlines or reference 
guides.

Vertical text alignment
 ○ Align text vertically in a text frame at top, bottom, center or justify positions.

Font height variations
 ○ Set the font size according to the Em Box, Cap Height, x-Height or ICF Box of the text.

Align to glyph bounds
 ○ Align objects precisely to the glyph bounds for the point and area text.

Unlock objects on canvas
 ○ Unlock objects easily from the canvas using the lock icon or context menu options.

August 2020 release (version 24.3)
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Adobe Illustrator 25 October 20, 2020

40 iA-Z

Adobe Illustrator | October 20, 2020

Recolor artwork
 ○ We’ve improved the recoloring feature to help you explore different color variations for your artwork. You can now pick a 
color palette from any artwork or images using Color Theme Picker and apply them in your designs. You can also use color 
variations instantly using predefined colors from color library or create your own colors using the color wheel. 

Enhanced Cloud Documents
 ○ The following enhancements are made to Illustrator cloud documents:
 ○ You can now embed your Adobe Photoshop cloud documents into Illustrator documents.
 ○ You can easily access previously saved versions of cloud documents, preview, mark, and revert to earlier versions as needed.
 ○ You can make your cloud documents available offline.

October 2020 release (version 25)
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Adobe Illustrator 25.1 January 2021

41 iA-Z

Add power to your vector art with repeats. Learn how to create radial, grid, and mirror repeat patterns in Illustrator.
 ○ Illustrator lets you easily repeat objects and manage their styles with a single click. All you need to do is to create the 
first object and choose a repeat type (Radial, Grid, or Mirror). Illustrator will auto-generate the complete artwork for you. 
Modifying repeats is also easy – just update one object and all instances are auto-modified to reflect the change. You can 
also modify the repeat patterns that are created using Illustrator on the iPad.

Adobe Illustrator | January 2021

January 2021 release (version 25.1)
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Adobe Illustrator 25.2 February 2021

42 iA-Z

Share access and edit Illustrator cloud documents
 ○ Illustrator now lets you collaborate seamlessly with your team members through the new Invite to Edit option. Use this 
option to send email invitations to people with whom you want to collaborate. Your collaborators can access the shared 
cloud documents directly from the Illustrator app, Creative Cloud Desktop, and Creative Cloud Website. You can either 
use Illustrator on the desktop or the iPad to send invitations. Similarly, collaborator can use any device to edit the shared 
documents.

Snap to Japanese glyph
 ○ The Snap to glyph feature has been enhanced to support Japanese glyphs and fonts as well. To enable this feature for 
Japanese, go to Preferences > Type > Language Options and select the Show East Asian Options check box. Two new 
Japanese-specific snapping guides–Embox and Embox Center–will be available along with the existing snapping guides.

System compatibility report on app launch
 ○ You will now receive a system compatibility report dialog on launching the Illustrator app if your GPU drivers are outdated. 
Follow the fix link in this report to quickly update the drivers. To export this report in a text file, click Export Report. To view 
this dialog again, choose Help > System Compatibility Report.

Adobe Illustrator | February 2021

February 2021 release (version 25.2)
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Adobe Illustrator 25.3 June  2021

43 iA-Z

Adobe Illustrator | June 2021

June 2021 release (version 25.3)

Rotate view
 ○ Illustrator now lets you rotate the canvas view and change the canvas direction to any angle using the Rotate View   tool. 
All your artboards and visible objects will also be rotated along with the rotation of the canvas view. You can easily modify 
and edit your artwork in rotated view just like the way you work in normal view. To bring the canvas view back to its original 
position, choose View > Reset Rotate View. You can also save the rotated view as a preset for future use.

Apple Silicon Support
 ○ Illustrator now runs natively on Apple computers with the Apple silicon M1 chip. Experience faster performance while 
using Illustrator on Apple computers.

Paste text without source formatting
 ○ Illustrator now lets you copy text from one document and paste it into another document without retaining the source 
format. Now, you don’t need to remove individual source formats from your document. Simply choose the  
Edit > Paste without Formatting option to remove the entire formatting in one click.

Delete Hidden Layers
 ○ The Layers panel now lets you delete hidden layers and sublayers. It is useful when you want to quickly delete all the 
hidden layers that are not relevant to your artwork. In the Layers panel, click More options and choose Delete Hidden 
Layers to delete all the layers and sublayers marked invisible.
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Adobe Illustrator 26 October 16, 2021

44 iA-Z

Apply 3D effects with re-imagined product experience
 ○ You can now easily apply 3D effects like Rotate, Revolve, Extrude, Lighting, and Shadows to vector artwork and create 3D 
graphics. Find all these effects along with Adobe Substance Materials and rendering options in a single 3D panel.

Add textures using Adobe Substance materials
 ○ You can add texture to your artwork using Substance materials and create realistic 3D graphics. You can either add your 
own material or choose from the free community and Adobe materials. You can also add thousands of Adobe Substance 
3D materials with a subscription plan.

Share for commenting
 ○ You can share a link to your artwork with collaborators, team members, or anyone. Reviewers with the link can now view 
your artwork and share feedback for seamless collaboration. You can view review comments in the shared document from 
within Illustrator.

Contextual self-guided content with discover panel
 ○ You can now learn about the new features with ease and get quick help using the Discover panel. The panel also gives you 
recommendations based on your skills and your work. These recommendations include tips and tutorials on how to get 
multi-step workflows done faster.

Seamless activation of missing fonts
 ○ You can now load your documents on any computer and work seamlessly without having to manually fix the missing fonts. 
The missing fonts are replaced with the matching fonts from Adobe Fonts.

Adobe Illustrator | October 16, 2021

October  2021 release (version 26)
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Enhanced productivity with Select same text
 ○ You can now select all the text boxes in a document and change text characteristics at a time. Extended functionality of 
Select Same enables you to select a text based on font size, text fill color, font style, and font.

Place linked cloud documents
 ○ You can now place or embed linked PSD cloud documents in Illustrator documents. Update or relink your PSD cloud files 
and embed them into your artboard when you want to edit the file.

Support for HEIF or WebP formats
 ○ You can now open or place High-efficiency Image Format (HEIF) or Web Picture (WebP) format files in Illustrator. To access 
HEIF format files in Illustrator on Windows, you will need codecs files.

Simplified variable-width stroke
 ○ You can now adjust or expand the variable-width strokes easily with fewer anchor points as Illustrator applies simplified 
paths on the strokes.

Adobe Illustrator | October 16, 2021

October  2021 release (version 26)
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Adobe Illustrator 26.1 February 28, 2022

46 iA-Z

Create symmetrical 3D objects with Bevel and Inflate
 ○ You can now create symmetrical and realistic 3D objects, by applying 3D types like Bevel and Inflate to both sides of an 
object.

Enhanced productivity with automated 3D object shadow alignment
 ○ When working on 3D objects and materials in Illustrator, you can save your time with the automated 3D object shadow 
alignment. The shadow of your 3D object auto-adjusts to reflect the object’s shape as you modify the Lighting options 
within the 3D and Materials panel. The shadow is auto-adjusted when working on the Ray Tracing mode.

Simplified workflows with multi-rotation of 3D objects
 ○ Illustrator enables you to rotate multiple 3D objects simultaneously with different 3D properties around their axis. You can 
either use the Rotation options within the 3D and Materials panel or the widget that appears when you select 3D objects.

Adobe Illustrator | February 28, 2022

February 2022 release (version 26.1)
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Adobe Illustrator 26.3.1 May 10, 2022Adobe Illustrator 26.3.1 May 10, 2022

47 iA-Z

Add perspective to 3D objects
 ○ Add perspective to 3D objects with Perspective Camera, which lets you make precise rotation adjustments and angles to 
capture a specific viewpoint.

Drag and drop graphics to 3D panel
 ○ You can now easily add new graphics to the 3D panel by using drag and drop from the document. Select an artwork and 
include it as a Graphic from the Materials tab to make it available for mapping. 

AVIF format support
 ○ Illustrator now supports AVIF file format. AVIF is an image file format that uses the AV1 compression algorithm. AV1 is an 
open format initially designed for video transmission over internet.

Adobe Illustrator | May 10, 2022

May 2022 release (version 26.3.1)
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48 iA-Z

Create lists with the text
 ○ You can now add variety to the text that you use for your designs by using bulleted and numbered lists easily. Both the lists 
help your users identify the key points in the text in ordered and unordered forms. 

 Manage states with history panel
 ○ You can use the history panel to jump to any recent state of the design you created during the current working session. 
Each time you add any elements to the design, you can see new states being added to the history panel. 

Expand objects as wireframes
 ○ Use wireframes to view the underlying structure of your 3D object to ensure accuracy. You can also export wireframes as 
line drawings for future reference. 

Export 3D objects with colors
 ○ You can now export 3D objects as OBJ files along with colors. When you export multiple objects, you can view each object 
as an independent modifiable object. 

Render map artwork as vector
 ○ You can now render map artwork also as a vector graphic along with the 3D object.

Adobe Illustrator | July 25, 2022

July 2022 release (version 26.4.1)
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Adobe Illustrator 2023 27.0 October 18, 2022

49 iA-Z

Partially overlap objects with Intertwine
 ○ You can now reorder or overlap text, shapes, and objects to create an overlapping pattern in your artwork.

Share Illustrator documents for review (Beta)
 ○ Share for review lets you create a shareable link on which stakeholders can provide feedback even without an Adobe 
account. You can automatically get the feedback in Illustrator to which you can reply, resolve, and push updates to the 
same review link to continue the review cycle.

Retain format when pasting text between Illustrator and InDesign
 ○ Now you can copy any text from InDesign and paste it into your Illustrator document while preserving the text style, 
format, and effect.

Automate Illustrator workflows with Quick actions
 ○ With the latest addition to Discover Panel, Quick actions let you complete workflows with a single click. Use the curated 
list of quick actions to give a retro, old-school style, or neon-glow effect to your text, instantly. You can also convert hand-
drawn sketches to vector images or recolor artwork using quick actions.

Additional compatible formats to export 3D objects
 ○ Illustrator lets you export 3D objects to GLTF and USD file formats that are widely compatible with Adobe Substance 3D 
and other 3D apps. You can import the assets into your favorite 3D applications to edit and enhance them.

Improved performance in placing multi-linked files
 ○ When placing multiple linked files or images in PNG format, the file loading and opening time has comparatively improved.

Adobe Illustrator | October 18, 2022

October 2022 release (version 27.0)
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Pantone Color Books 
 ○ Some Pantone color books have been removed due to changes in Pantone’s licensing with Adobe.

https://helpx.adobe.com/illustrator/kb/pantone-color-books-illustrator.html

Bug fixes and performance enhancements.
 ○  All PNG images are turned into negatives after the document is saved and reopened.[macOS] 

 ○ In the Appearance window, the Transparency panel does not work when you press Enter [macOS] 

 ○ In the Color picker tool, when you right-click to paste values in the Hex Value field, the field and Illustrator do not work 
Illustrator crashes on launch.

 ○ Double extensions are added to packaged PSD links 

 ○ Color blends show inaccurately in isolation mode

Adobe Illustrator | November 18, 2022

Version 27.01
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Enhancements to Image Trace
 ○ Auto-detects High Fidelity Photo, Low Fidelity Photo, Sketched Art, Line Art, and Logo art types and selects the 
corresponding preset for you.

 ○ Provides cleaner output for the Sketched Art preset.

 ○ Improves the output for small-sized images.

Preview color and opacity in Real Time
 ○ You can live preview color change, opacity change, and new swatch creation.

Convert bullets and numbering to editable text
 ○ You can convert bullets and numbering to editable text.

 ○ Select Type > Bullets and Numbering > Convert to text.

Adobe Illustrator | December 5, 2022

December 2022 release (version 27.1)
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Illuminate 3D objects using multiple lights
 ○ You can add up to ten light sources to your 3D object and adjust the lighting angles to accurately capture time and 
ambiance in your artwork. You can also let your object cast multiple shadows to make your artwork look more real. Preview 
color and opacity in Real Time

Reveal the structure of 3D objects using wireframes
 ○ You can render your 3D object as a wireframe to view its underlying structure and focus on its dimensions, angles, and 
perspectives. Once you render your object as a wireframe, you can make easy edits to its 3D properties.

Find overlapping areas of objects to click and intertwine
 ○ You can locate overlapping areas of selected objects as you hover over them, making it easier to intertwine with just a click.

Reuse asset export settings
 ○ You can save asset export settings as presets so that you don’t have to specify scales and file formats each time you export 
assets. You can also export and import these presets to maintain consistency across projects.

Search for document versions
 ○ You can add descriptions to your document versions to easily identify them later. You can search for document versions 
using names and descriptions, or by choosing timestamp or bookmark filters.

Secure review links using password
 ○ You can password-protect your public Share for review (Beta) link, making it secure. If you invite reviewers by email, they 
don’t need to enter the password to access the link. If you disable the password requirement and enable it later, you have 
to create a new password.

Adobe Illustrator | February 22, 2023

February 2023 release (version 27.3)
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Sample colors using the Color Picker
 ○ You can use the eyedropper from the active Color Picker to sample colors from anywhere on the Illustrator canvas.

Locate linked or embedded files on the computer
 ○ After you place a file in a document, you can locate it on Windows explorer (Windows) or Finder (macOS) easily by 
navigating to the Links panel. 

Improvements to pan, zoom, and scroll 
 ○ You can experience better performance with pan, zoom, and scroll as Illustrator temporarily hides annotations such as 
bounding boxes and guides.

Improvements to Image Trace
 ○ Illustrator enhances your Image Trace experience in the following ways:

 ○ Detects High Fidelity Photo, Low Fidelity Photo, Sketched Art, Line Art, and Logo art types and auto-selects the 
corresponding tracing preset for you.

 ○ Improves the tracing output for small-sized images.

Improvements to color settings
 ○ The following are the improvements to color settings:

 ○ Illustrator remembers the last used color mode so that you can continue with your preferred color scheme whenever 
you open Illustrator.

 ○ The Gradient panel now reflects the color mode selected in the Color panel instead of starting with Grayscale.

Adobe Illustrator | February 22, 2023

February 2023 release (version 27.3)
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Share for Review
 ○ Share for review lets you share a secure link to a specific document version with stakeholders for review, and then view and 
respond to their comments directly in-app. 

 ○ You can share documents in two ways:

 ○ Share for review. Share local or cloud documents for review and push updates when needed.

 ○ Invite to Edit. Share cloud documents for editing.

Adobe Illustrator | March 31, 2023

March 2023 release (version 27.4)

https://indd.adobe.com/view/0bff348c-febc-4351-8a11-8101037228d9
mailto:jameswamser%40mac.com?subject=Illustrator%20New%20Features%20Guide


Contents Index Favorites Info OnlineFeedback

Adobe Illustrator 2023 27.5 April ( ), 2023

55 iA-Z

Adobe Illustrator | April, 2023

April 2023 release (version 27.5)

Experience improved app performance
 ○ You can now experience better performance with improved live edits and optimized rendering of snapping guides and 
annotations.
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Adobe Illustrator | May, 2023

May 2023 release (version 27.6)

Retype (Beta)
 ○ Retype (Beta) lets you identify the fonts used in raster images and outlined texts, without leaving any scope for guesswork, 
Next time you come across a font anywhere, take a photo and bring it into Illustrator, and let Retype (Beta) identify the font 
for you! Once you identify the font, apply it to text instantly and try it in your design.

Image Trace with Improved workflows
 ○ You can now enjoy an improved image trace experience:

 ○ Get a redesigned Image Trace panel.

 ○ Image Trace can auto-detect the art type and apply the corresponding tracing preset for you.

 ○ Use Ignore Color to remove a color of your choice from the tracing result by choosing the Method as Abutting.

 ○ Use Simplify to reduce the number of anchor points in the tracing results by choosing the Method as Abutting.

Search and filter layers and objects with ease
 ○ You can type in a layer name or object name, or use the layer and object filters in the Layers panel to quickly locate the 
specific layers and objects.

Export artwork as a WebP image for use in websites and apps
 ○ You can now export your artwork as a WebP image. WebP images are smaller in file size compared to JPEG and PNG while 
maintaining high image quality, and hence are suitable for websites and mobile apps. Also, with WebP images, you have 
the  flexibility of choosing between lossless and lossy compression as a trade-off between image quality and file size.
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Retain hyperlinks in exported PDFs
 ○ PDF files exported from Illustrator now retain the text and image hyperlinks that you set through the Attributes panel.

Retain last used PDF preset as the default
 ○ Illustrator remembers the last preset used for saving PDF files and keeps it as the default preset.

Set a color model specifically for JPEG Export for Screens
 ○ You don’t have to change your document’s color model just to export JPEG for screens. When you export JPEG for 
screens, you can set the color model as RGB, CMYK or Grayscale regardless of the color model of the document. Illustrator 
remembers the last color model used for export until you restart Illustrator

Find the precise value of HSB and CMYK colors accuracy
 ○ You can find the HEX value of HSB and CMYK colors consistency and accuracy throughout your artwork.

Adobe Illustrator | May, 2023

May 2023 release (version 27.6)
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Search and filter layers with more control
 ○ You have more flexibility and control when you search for layers and objects in the Layers panel. You can use the new Guide 
filter to find guides-enabled objects, and also apply multiple filters at the same time.

Explore a user-friendly toolbar with enhanced accessibility
 ○ The toolbar drawer (the list of tools you get when you select    in the toolbar), is more accessible than ever before. As you 
navigate through the drawer, your screen reader can read the names of the tools for you.

Adobe Illustrator | June 2023

June 2023 release (version 27.7)
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Gather feedback on specific artboard
 ○ Generative Recolor, fueled by Adobe Firefly, Adobe’s family of creative generative AI models, lets you effortlessly transform 
the colors in your vector artwork into compelling color schemes. Enter a simple description of the desired color theme 
or palette, and quickly get multiple variations as output. Try out these variations and choose the most fitting one for your 
artwork.

Experience improved accessibility with VoiceOver (macOS only)
 ○ The VoiceOver utility on macOS reads the names of the tools in the toolbar when you press the corresponding keyboard 
shortcuts, making the tools more accessible. VoiceOver also reads the names of artboards in Presentation Mode, making 
navigation easier.

Adobe Illustrator | July 2023

July 2023 release (version 27.8.1)
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Use text prompt to recolor artwork with ease
 ○ Generative Recolor, fueled by Adobe Firefly, Adobe’s family of creative generative AI models, lets you effortlessly transform 
the colors in your vector artwork into compelling color schemes. Enter a simple description of the desired color theme 
or palette, and quickly get multiple variations as output. Try out these variations and choose the most fitting one for your 
artwork.

Accelerate creative workflows using Contextual Task Bar
 ○ The Contextual Task Bar surfaces the most relevant next actions for the object you select, right in the object’s vicinity, 
allowing you to accomplish your creative goals faster, and helping you find interesting workflows.

Identify local fonts used in images and outlined text
 ○ When you use Retype (Beta) to identify the fonts used in images and outlined text, it now returns any matching fonts 
present in your computer in addition to any matching fonts from Adobe Fonts, significantly expanding the range of fonts it 
can identify

Adobe Illustrator | September 2023

September 2023 release (version 27.9)
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Transform creative ideas into vector graphics with ease
 ○ Text to Vector Graphic (beta), powered by Adobe Firefly, Adobe’s family of creative generative AI models, lets you generate 
compelling vector graphics effortlessly. Enter a simple description of the desired subject, scene, icon, or pattern and quickly 
get multiple variations as output. Try out these variations and select the one that perfectly aligns with your artistic vision.

Create realistic mockups of art on objects
 ○ Mockup (beta) allows you to create imitations of art on objects such as product packaging, mugs, and T-shirts. When you 
apply vector art on a raster object, Illustrator honors the curves and edges of the object, and the vector art auto-adjusts 
onto the object non-destructively.

Convert text within images and outlined text into live text for editing
 ○ Use the power of Retype (beta) to edit static text within a raster image or outlined text using a matching font from Adobe 
Fonts or your computer.

Smoothen paths with more control
 ○ The Smooth slider, an enhancement over the Smooth   tool, lets you manually control smoothing levels for a path. You also 
have the flexibility to smoothen the entire path or a part of the path. 

Create shareable links to PDF files for review
 ○ Share for review lets you create shareable links to your PDF files for gathering feedback without having to convert them to 
.ai or .aic files.

Adobe Illustrator | October 10, 2023

October 2023 release (version 28)
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Custom Tools panels ......................................................................................14
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Rotate view ..........................................................................................................43
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